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EndNote

Sie kénnen mit EndNote eigene Literaturdatenbank erstellen und z. B. in den MBI-EndNote-
Datenbanken recherchieren.

Die Publikationsdatenbanken des MBI enthalten alle Publikationen, Vortrage und andere relevante
Information des MBI. Sie konnen mit Hilfe der EndNote Software auf diese Datenbanken lesend
zugreifen. Samtliche Eintrage in die EndNote Datenbanken werden von den Bereichsekretariaten
getatigt.

Die relevanten Datenbanken finden Sie auf dem Netzwerk-Share
\\group\group\info\Bibliography\endnote und sie heiBen mbi-a-X2.enl, mbi-b-X2.enl, mbi-c-
X2.enl und mbi-z-X2.enl - die zusammenfassende Datei heilt mbi-all-X2.enl.

Installation

Vor der Installation noch ein wichtiger Hinweis: als Angehoriger des MBI kénnen Sie EndNoteX5
auf beliebig vielen Rechnern installieren, sofern diese im Zusammenhang mit Ihrer Tatigkeit am
MBI stehen. EndNoteX5 lauft auf Windows XP, Windows 7 32- und 64-Bit. Eine Version fir Mac
OSX stellen wir Ihnen ebenfalls zur Verfligung — eine Anleitung zur Installation finden Sie unter
http://www.endnote.de/instmac. Auf den Applikationsservern ist EndNoteX5 ab 02.05.2012
ebenfalls installiert. Sie mlssen dort beim erstmaligen Start die Konfiguration wie ab S. 9
beschrieben vornehmen. Sollten Sie bereits eine adltere Version von EndNote installiert haben (z. B.
EndNoteX2), so wird diese nicht liberschrieben.

Entpacken Sie zunachst das Zip-Archiv ,,EndnoteX5-Win.zip“ an einem beliebigen Ort und
navigieren Sie im Anschluss in den entpackten Ordner ,EndnoteX5-Win“, Der Ordner enthalt die
drei Dateien ,,ENX5Inst.msi” , License.dat” und , MBI-ReferenceTypes-X5.xml“, wie in Abbildung 1
dargestellt. Fiihren Sie einen Doppelklick auf ,ENX5Inst.msi“ aus — beachten Sie: unter Umstanden
bendétigen Sie unter Windows 7 administrative Rechte fiir die Installation von Software. Bitte
wenden Sie sich in diesem Fall an Ihren Abteilungsadministrator. lhren zustandigen
Ansprechpartner finden Sie unter https://intern/de/edv/structure/local_support.html.

(% | 0 ¢ EndMoteX5-Win

sieren - In Bibliothek aufnehmen = Freigeben far - Brennen Meuer Ordner
Mame Anderungsdatum Typ Grofe
ﬁ! EMXSInst.msi 05.03.201217:07 Windows Installer... 66,837 KB
|| License.dat 05.03.2012 17:07 DAT-Datei 1KE
! =] MBI-ReferenceTypes-X5.xml 12.04.201213:39 AML-Dokument 88 KB

Abbildung 1 | ENX5Inst.msi ausfiihren

Fahren Sie im Anschluss mit der Installation wie im Folgenden beschrieben fort.
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EndNotex5 Setup — Abbildung 2.

43 EndNote ¥5.0.1 Setup

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

B Let EndMote locate full
text automatically

B Export directly from your
faverite online sources

B Collaborate with others
using EndMote Web

E THOMSOM REUTERS

Welcome to the EndNote X5.0.1 Installation

[t iz strongly recommended that you exit all Windows programs
befare running thiz zetup program. Click Cancel ba quit the zetup
program and cloze any programs vou have running. Click Mest to
continue the installation.

EndMate #5 stores your file attachments on the desktop and
YWeh. Join milionzs of researchers, students, and libranans whao
depend on EndMote to arganize references and full kext PDFs, az
well az create bibliographies in over 5,000 publishing styles.

Thank. you far choozing EndHote and enjoyl

The Endote Team
Thomzon Reuters

WARMIMG: Thig program iz protected by copyright law and
international treaties.

[Inautharized repraduction or diztribution of thiz pragram, or any
portian of it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

< Back [ M et » J [ Cancel

k.

Abbildung 2 | EndNoteX5 Setup

Akzeptieren der Lizenz — Abbildung 3 auf S. 4.
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4 EndNote X5.0.1 Setup

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & moare

B Let EndMote locate full
text automatically

B Export directly from your
favorite online sources

B Collabarate with others
using EndMete Web

" THOMSOMN REUTERS

EndNote X5.0.1 Volume License Ver...

Thiz copy of EndMote #5.0.7 iz icenzed to:

Licensee: Leibriz-Gemeinzchaft

Senial Number: 5031503643

By clicking the "Accept” button, | have obtained permizzion to
uze thiz copy of EndMote #5.0.1, and | have accepted the
valume license agreement for Leibriz-Gemeinzchaft, izsued by
Thormnson Reuters.

Click. "Cancel" button to quit thiz installation if you hawe not
obtained permizzion to use, or pou do not want to accept the
license agreement for this software.

< Back ][ Accept » J [ Cancel

b

Abbildung 3 | Lizenzinformation

ReadMe-Informationen = Next wahlen — Abbildung 4

.
13 EndNote X5.0.1 Setup

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

B Let EndMote locate full
text automatically

B Export directly from your
faverite online sources

B Collaborate with others
using EndMote Web

M THOMSON REUTERS

Read Me Information

EndMaote X5 Read Me
Wersion X5 (15.0.7)
Movember 2011
Thomson Reuters

[ ] »

CONTENTS:

[. NEW FEATURES
[Il. RELEASE NOTES
I INSTALLATIONS
V. CONTACT INFORMATION

I. NEWW FEATURES

* Add and transfer file attachments to references in your

EndMote Web account for areater mobility. Uparade or create

< Back ][ M et > ] [ Cancel

[

Abbildung 4 | ReadMe

End User License Agreement akzeptieren — Abbildung 5 auf S. 5.
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44 EndNote ¥X5.0.1 Setup

[

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

B Let EndMote locate full
text automatically

B Export directly from your
favorite online sources

B Collaborate with others
using EndMote Web

s
i THOMSOM REUTERS

End User License Agreement

EndMote(R) End User
License Agreement

THE TERMS AND CONDITIONS OF THIS AGREEMENT
SHALL NOT APPLY IF YOU HAVE OBTAINED ACCESS TO
THIS PRODUCT PURSUANT TO A MULTI-USER LICENSE.
UNDER SUCH CIRCUMSTANCES, YOUR USE OF THIS
PRODUCT SHALL BE GOVERMNED SOLELY BY THE
TERMS AND CONDITIONS OF THE MULTI-USER
LICEMSE.

BACKGROUMD. Thamson Reuters (Sciertific) Inc. has
developed a proprietany computer program designated
"EMDMOTE" fthe "Software"). You the “End User™) may use
the Software to create personal bibliographic databases and
to search those databases. By using the Software andorits
accompanying manuals {he “Documentation”™ and together
with the Software. the “Product™. vou aagree with Thomson

@ | accept the license agreement
(71| do not accept the license agreement

< Back ][ M et > ] [ Cancel

Abbildung 5 | End User Lizenz akzeptieren

Installation Type ,,Custom” wahlen — Abbildung 6

2 EndNote X5.0.1 Setup

Select Installation Type

Typical

E N D N OT E All application features and the Mozt Popular Bibliographic

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

BN Let EndMote locate full
text automatically

B Export directly from your
fawarite online sources

B Collaborate with others
using EndMote Web

M THOMSON REUTERS

Output ztules, Online Connections, and Impart Filters will be
inztalled. This option iz recommended for the best
performance.

@ Custom

|z& this option to choose specific application features and
arny Bibliographic Output Styles, Online Connectionz, and
[mpart Filkers you want to inztall in addition to the kMost
Fopular filez. Thiz is recommended for advanced EndMote
Lizers.

< Back ][ Mewt > ] [ Cancel

Abbildung 6 | Installation Type > Custom

Installationsordner; Voreinstellung sollte nicht gedndert werden und variiert je nach Windows-
Version (XP, 7) — Abbildung 7 == Windows 7 64-Bit!
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4 EndNote ¥5.0.1 Setup SRR

Select Destination

The “Wize Installation “wWizard will inztall the files for Enddate
#5 in the following falder.

i
B | & 1oinztall into a different folder, click the Browse button, and
E N D N OT E select anather folder.

Advance your Research
and Publish Instantly
B Manage references, PDFs,
figures, tables & more Diestination Folder
B Let EndMote locate full

B C:\Pragram Files [+86]\EndNate %5

B Export directly from your
favorite online sources

Y'ou can choose not ta install EndMate #5.0.1 by clicking
Cancel to exit the Wize Installation wizard.

W Collaborate with others
using EndMaote Web

& H THOMSOM REUTERS

< Back ][ MHext > ] [ Cancel

Abbildung 7 | Installationsordner - Einstellung nicht @ndern

Zu installierende Features auswahlen — Abbildung 8. Relevant ist hier nur die Kategorie ,, Additional
Styles”. Wahlen Sie hier bitte die zu Threm wissenschaftlichen Gebiet passenden Stile. Die Stile
LExport” und , Generic” missen IMMER ausgewahlt werden. Fiir das MBI haben sich neben
,Export“ und ,,Generic” die Stile ,Chemistry“, ,Mathematics” und ,,Science” bewahrt. Bestatigen
Sie im Anschluss mit , Next”.

Es B
4 EndNote X5.0.1 Setup ESN IR

Select Features
------- = ~ | Additional Filters -
= Additional Styles
g | i e ¥ | Agriculture
T S S - ¥_~| Anthropalagy i
E N D N OT E’ --------- ¥ | Artz and Hurnanities
--------- ¥ | Behavior Sciences
Advance FFW Research | = ? Businesz and Economics =
and Publish Instantty | | "=9=] Chemistry
- :‘;':J':'Eg: ::LELLES";:;J:'EDFS‘ --------- » - Eummunicatiuns andMedia |
W Let EndMote locate fut | 1 £ Dentistry
text automatically | i i ¥ _~| Ecology
B Export directly from your [ 1 7T £ Education
favorite online sources [ 0 e ¥ ~| Engineenng and Technology
B Collaborate with others | | e =~ | Export
using EndMote Web | 1 i =~ | Generic -
THOMSON REUTERS Ingtall Direct E xport Helper
[ Diigk Ciozt ] [ Rezet ] [ < Back ][ P et > J [ Cancel

[
Abbildung 8 | Features
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Default-Einstellung wie in Abbildung 9 beibehalten und mit ,Next” bestétigen.

fE] EndMote X5 Setup |. = &

Select Default Citation Manager

EndMote #5.0.1 Inztallation \wWizard has detected a wersion of
4 Microzoft \wWord with a citation management feature installed on
_ thiz computer. You have choszen to install EndMote's Cite while
@ You'wite. Please check the checkbox below to uze EndMaote
as your default citation manager for Microsoft \ord,
Advance your Research
and Publish Instantly

B Manage references, PDFS,
figures, tables & more

|ze EndMote az my default citation manager

W Let EndNote locate full Click the Back button ta change the selection far this inztallation,
text automatically
W Export directly from your Chck the Mext button to continue the installation.

favaorite anline sources

B Collaborate with others Click. the Cancel button to quit this installation.

using EndMNote Web

"3 THOMSOM REUTERS

¢ Back ][ Mest > ] [ Cancel

[%

Abbildung 9 | Default-Einstellung

Im nachsten Dialog beginnen Sie mit der Installation. Klicken Sie auf ,,Next“ — Abbildung 10.

14 EndNote ¥5.0.1 Setup = S|

Use EndNote on the ]
desktop and Web Ready to Install the Application

W Save retyping references
B Format citations and the
biblisgraphy in seconds Click the Back button to reenter the ingtallation information or

B Format citations in owver click Cancel to exit the wizard.
5,000 publishing styles

W Search and annotate PDFs Before proceeding, make zure you are logged into the local

® Add or transfer PDF/files !'nan:hi_ne with_ a;lministrative rights anu:_l that no other programs,
ta and from EndNote Web including anti-viruz zoftware, are inning.

E N D N OT E Click Mest to begin inztallation.

< Back ][ '&'Ne:-:t) ] [ Cancel

Abbildung 10 | Installation beginnen

Die Installationsprozedur beginnt — Abbildung 11.
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1 EndNote X5.0.1 Setup | = S |

Use EndNote on the .
desktop and Web Updating System

B Save retpaine safaeansne .

EndMote ¥5.0.1 Setup

B Format
bibliog
B Format
5,000

W Search

° — |

Owerall Progress

Current Operation

Eutracting Library Catalogs Connections...

Cancel

Abbildung 11 | Installationsprozedur abwarten...

Nach Abschluss der Installation wahlen Sie , Finish” — Abbildung 12.

-
43 EndNote X3.0.1 Setup =N

Learn about EndNote
www.endnote.com EndNote X5.0.1 has been successfully

installed.
B Facebook/EndMote

Twitter @EndMoteMews
YouTube/EndMataTralning Click. the Finish buthaon to exit thiz inztallation.

B Register or buy your
copy of EndMote today

B View online tutorials and
sign up for a Web class

B Free Technical Support
and user forum

ENDNOTE

i)

S .

Abbildung 12 | Installation abschlieBen
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Aufbau einer eigenen Datenbank mit ISI Web of Science und EndNote

Mit EndNote X5 kénnen Sie auf einfache Weise Publikationen in eine eigene Literaturdatenbank
aufnehmen. Das folgende Beispiel zeigt, wie Sie eine Publikation aus ISI Web of Science in EndNote
X5 importieren und diese dank der cite-while-you-write-Funktion (siehe S. XY) auf einfache Weise
in lhrer eigenen Arbeit Referenzieren kénnen.

Zunéchst sollten Sie sich Ihre eigene Datenbank anlegen. Offnen Sie EndNote und wiahlen Sie tiber
das Programm-Men die Option ,File“ 2 ,New” — Abbildung 13. Wahlen Sie als Speicherort fiir die
Datenbank einen beliebigen Ort, z. B. Ihr home-Laufwerk.

7 noncre s T

’File] Edit References Groups Teools Window Help

Mew...
Open 2

Cloze

Abbildung 13 | File > New

Im Anschluss wird lhnen die noch Leere Datenbank angezeigt — Abbildung 14.

P2 EndNote X5 - My EndNote Library

File Edit References Groups Tools Window Help

E2| My EndMote Library.enl

@) % © |[Amoses EHD0QOOE

vo &

My Library B Author Year Title
M All References

# Unfiled (0)

W Trash (0)

=~ My Groups

= Online Search
O Library of Con...  (0)
O LISTA (EBSCO) (0)
©.PubMed (NLM) (0)
O Web of Scienc... (0)

mare...
Abbildung 14 | Leere Datenbank

SchlieRen Sie EndNote wieder.

EndNoteX5 9



Rufen Sie nun in einem Browser die Webseite apps.isiknowledge.com auf. Dort kdnnen Sie mit
Hilfe der Suchfunktionen in verschiedenen Publikationsdatenbanken recherchieren. Beispiel hier:
Web of Science — Abbildung 15.

WERB OF KNOWLEDGE™ ‘ DISCOVERY STARTS HERE

Go to mobile site | signin | MarkedList(0) | MyEndt

All Databases Select a Database Web of Science Additional Resources

Search | Author Finder | Cited Reference Search | Advanced Search | Search History
Web of Science s

Search

Example: oil spill* mediterranean

| |
Example: O'Brian C* OR OBrian C*
Meed help finding papers by an author? Use Author Finder.

| |

Example: Cancer® OR Journal of Cancer Research and Clinical Oncology
Abbildung 15 | Suche im ,,Web of Science*

So konnte ein Suchergebnis nach Autor ,,Elsaesser aussehen — Abbildung 16:

< T | & B saveto: ( EndNoleweb | [ EndNot® | [ RefWorks ) [ F

1. Title: Coronary artery fistula with myocardial infarction due to stea
Author(s) Haerle Tobias; Kronberg Kay; Elsaesser Albrecht
Source: CLIMICAL RESEARCH IM CARDIOLOGY Volume: 101 Issue: 4 P:
Times Cited: 0 (from Web of Science)

Context Sensitive Links = Full Text )

2. Title: PG 1553+113: FIVE YEARS OF OBSERVATIONS WITH MAGIC
Authior(s): Aleksic J.; Alvarez E. A Antonelli L. A et al.
Source: ASTROPHYSICAL JOURMAL YVolume: 748 Issue: 1 Article Mumb
Times Cited: 0 (from Web of Science)

Context Sensitive Links > Full Text ) r o viiew abstract ]

3. Title: Ab initio investigation of surface stress response to charging
Author(s) Albina J. -M; Elsaesser C; Weissmueller J.; et al.
Source: PHYSICAL REVIEW B Volume: 85 Issue: 12 Article Mumber: 125
Times Cited: 0 (from Web of Science)

Context Sensitive Links " Full Text | o sriew abstract ]
Abbildung 16 | Auflistung der Suchergebnisse

Durch Auswahl (Markieren der gewiinschten Titel) und anschliefendem Klick auf den EndNote
Button kdnnen Sie die Publikationen sofort importieren.

EndNoteX5 10


apps.isiknowledge.com

+
Durch Klick auf den Button ]

Fligen Sie die Auswahl zur ,,Marked List“ hinzu. Durch Klick auf den Link ,,Marked List” gelangen Sie
zur Zusammenfassung der Auswahl und Sie kdnnen dort zusatzliche Import-Option einstellen —

Abbildung 17.

Marked List (2 records)
<< Exit Marked List

Your marked list containg records from 1 database(s).
Y¥ou can output summary data for all records using the “total records” view, or output more product-specific data from each listed datat

‘ 2 total records on the Marked List

Output author, title, source, abstract, and times cited for all records in the Marked List.

2 records from Web of Science ¥¥
Quiput complete data from this product for these records.

Output Records
Step 1:

© All records on page

@ All records in this list {up to 500)

[ = Hide Output Options |

Step 2:

© Records | | to |

Author(s) / Editor(s)
[ Abstract*

[C] Addresses

ISSN /ISBN

[l 10S Number

O Funding Information

[Reset]

Title

[C] cited References*
Times Cited

IO cited Reference Count
O Language

Accession Number

*Selecting these iterms will increase the processing lime.

Abbildung 17 | Zusitzliche Optionen bei Nutzung der "Marked List"

Select from the fields below:

Step 3:

% [ Savetor

EndNGlE Web

[How do | export to bibliographic managemer

EndNal®

| Save to other Reference Software El Save

Source

| Document Type

[ Keywords

O] source Abbrev

[C] Web of Science Category

Conference
[C] conference
[C] Pubiisher ir
O Page Count
[C] subject Cat

Aktivieren Sie im nachfolgenden Dialog die Option wie gezeigt und Bestatigen Sie im Anschluss mit

OK — Abbildung 18.

Offnen von savedrecs.ciw

Sie machten folgende Datei herunterladen:

B savedrecs.ciw

Viom Typ: ISl Commen Export Format
Von: http://ets.webofknowledge.com

Wie soll Firefox mit dieser Datei verfahren?

@ Offnen mit

Research5oft Direct Export Helper (Standard) -

() Datei speichern

gedndert werden

Fir Dateien dieses Typs immer diese Aktion ausfihren

Optionen kénnen im Anwendungen-Fenster in den Firefox-Einstellungen

0K Abbrechen

Abbildung 18 | Dateityp o6ffnen ...

EndNote startet im Anschluss automatisch und die soeben ausgewdahlten Publikationen sind dann
in Ihrer personlichen Referenzdatenbank vorhanden.

EndNoteX5
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Optional: Zugriff auf eine MBI-EndNote-Datenbank

EndNoteXS5 fiir die Arbeit am MBI anpassen

Zum Arbeiten mit den MBI-Datenbanken ist es ratsam (aber nicht notwendig) im Vorfeld die MBI-
Praferenzen zu importieren.

Starten Sie EndNote (Start 2 Programme). Innerhalb des EndNote Fensters wahlen Sie wie in
Abbildung 19 gezeigt den Menipunkt , Edit”“ und , Preferences”.

AR ——

File | Edit | References Groups Tools Window Help
Ctrl+Z

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Paste With Text Styles

Clear
Select All Ctrl+A
Copy Formatted Ctrl+K

Change Text... Ctrl+R
Font

Size

Style

Output Styles

Import Filters

Connection Files

Preferences...

Abbildung 19 | Edit > Preferences

EndNoteX5 12



Im nachsten Schritt wahlen Sie ,Reference Types” und ,Import“ — Abbildung 20.

e e ==

- Change Case

Reference Types
- Display Fields
. Display Fonts Default Refersnce Type: ’JOUI'HH| Atticle ']
- Duplicates

 EndNote Web
Modify Reference Ty
.. Find Full Text . =

- Folder Locations

.. Formatting Note: Use the Reference Types Table to add, delete, or rename field
Librari namesg or to modify reference types. The table CANNOT be used to

- Lioranes reorder the fields in a Reference Window.

- PDF

M Reference Types Reference Type Table

Changes made to Reference Types are stored in a special

- Sorting Ref TypeTable xaml file. Tao use a new file orto share your file with
- 5pell Check others, use these Import and Export options:
- Temporary Citations
- Term Lists
Export... Import...
. URLs & Links ’ ] ’ ]
Nate: Importing a new Ref Type Table xmil file will overwrite your curent
Reference Type preferences.
[ Endnote Defaults ] [ Revert Panel ] [ OK ] [ Abbrechen Obemehmen

Abbildung 20 | Reference Types > Import

Navigieren Sie nun in den Ordner, in dem sich auch die EndNote Installationsdatei befindet (siehe
Seite 2). Dort wahlen Sie dann lber Doppelklick die Datei ,MBI-ReferenceTypes-X5.xml“ aus —
Abbildung 21.

'w| i » EndNoteX5-Win

i 1
sieren - In Bibliothek aufnehmen = Freigeben far - Brennen Meuer Ordner
Mame . Anderungsdatum Typ Grofe
ﬁ_.E:r! EMX5Inst.msi 05.03.201217:07 Windows Installer... 66.837 KB
|| License.dat 05.03.2012 17:07 DAT-Datei 1KE
I |Z] MBI-ReferenceTypes-X5.xmil 12.04.201213:39 AML-Dokument 88 KB

Abbildung 21 | MBI-Reference-Types-X5.xml

Bestitigen Sie nun die Auswahl nacheinander mit ,Ubernehmen” und ,,0K“ — Abbildung 22 auf S.
14.

EndNoteX5 13



" EndNote Prefere_ [

- Change Case Reference Types
- Display Fields
- Display Fonts Default Reference Type: [Juuma] Adicle v]
- Duplicates
.. EndMote Web i
Modify Reference Types...
- Find Full Text [
.. Folder Locations
. Formatting Mote: Use the Reference Types Table to add, delete, or rename field
Librari names ar to modify reference types. The table CANMOT be used to
- Libranes rearder the fields in a Reference Window.
.. PDF
. Reference Types Reference Type Table
Sorti Chanages made to Reference Types are stored in a special
- aorng Ref TypeTable xml file. To use a new file orto share your file with
- Spell Check others, use these Import and Export options:
- Temporary Citations
-. Term Lists
Export ... Impart ...
- URLs & Links [ ] [ ]
Mote: Importing a new Ref Type Table xml file will overwrite your cument
Reference Type preferences.

Endnote Defaults | | Revert Panel OK || Abbrechen | | Ubemehmen

Abbildung 22 | Ubernehmen > OK

Wie auf Seite 2 beschrieben, liegen die Datenbanken auf einem Netzwerk-Share. Diesen kénnen
Sie wie gewohnt als Netzlaufwerk einbinden und dann tGber EndNote lesend auf die Datenbank
zugreifen.

Starten Sie hierzu EndNote und wéhlen Sie im Programm-Ment die Option ,,File“ = ,0Open” =
,Open Library” — Abbildung 23.

T ———————

IFlIe Edit References Groups Tools Window Help

Mew...

Open 2 Open Library... Ctrl+0

£ 1 ¥:\endnote\mbi-all-X2.enl

Save Ctrl+5 2 ¥Xhendnote\mbi-a-X2.enl

Save As... 3 My EndMote Library.enl

Save a Cnow...

Abbildung 23 | Datenbank 6ffnen

Wahlen Sie nun die gewtlinschte Datenbank (z. B. mbi-all-X2.enl) mit Doppelklick aus — Abbildung
24 auf S. 15. In diesem Beispiel wurde ein Netzlaufwerk ,X:“ mit dem Pfad
\\group\group\info\Bibliography\endnote verbunden (siehe auch Seite 2).
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@:i 'i|v| ) v Computer » Bibliography (Mgroup.mbi-berlinde\grouphinfo) (£:) » endnote »

Organisieren - Brennen

Meuer Ordner

.0 Favoriten

Bl Desktop
4 Downloads
&l Zuletzt besucht

1 Biblictheken
[ Bilder

Abbildung 24 | Datenbank auswadhlen

Mame

H’_ mbi-z-¥2.enl

H’_ mbi-z-X2 Copy.enl
H’_ mbi-c-¥2.enl

B mbi-b-X2.enl

H’_ mbi-a-¥2.enl

B mbi-all-X2.enl

Anderungsdatum

17.04.2012 07:47
27.03.2012 09:39
18.04.2012 14:39
18.04.2012 15:01
19.04.2012 05:01
19.04.2012 09:02

Da Sie keine Schreibrechte fiir die EndNote-Datenbank besitzen, erhalten Sie bei jedem Zugriff die
eine Fehlermeldung. Diese bestatigen Sie mit OK — Abbildung 25.

SO 00 e

The file "mbi-a-¥2.enl" is locked or is on a locked volume, Mo changes
will be saved.

Abbildung 25 | Warnmeldung bestétigen

Fertig — Abbildung 26.

EndMote X5 - mbi-a-

File Edit References Groups Tools

Window Help

mbi-a-¥2.enl

6] % ® |[oruas JH0QOOE| ¥ |HEW e~

My Library  ~ B Author Year Title
M All References (4339) N. Zhavoron... 2012 Interaction of femtosecond laser puls
@ Unfiled (4339) M. Zhavoron... 2012 Preparation of heavy glass samples .
il Trash (4) N. Zhavoron... 2012 Generation and characterisation of ul
H HYuH J. 2012 Manifestation of quantum disordered
=My Groups M.J.J. Vrak... 2012 Aftosecond-time-resolved molecular
=-My Smart Groups M. J.J. Vrak.. 2012 Atomic and molecular physics at FEL
@.01.20-2012 (1) M_J.J Vrak_. 2012 Coordinator of FP7 Marie Curie Indu
@.01.401-Bachelorl. (1) M. J.J Vrmak._. 2012 Coord!natcrr of FP7 Mar!e Cur!e In!t!e
@.0210-2012 4 M. J J Vrak .. 2012 Coaordinator of FP7 Marie Curie Initiz
. m'ﬂn_nm - (ﬂ} M. J J Vrmak.. 2012 Member of Joint Research Activity "2

Abbildung 26 | Teilausschnitt des Programmfensters mit gedffneter Datenbank
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Anbindung an Microsoft Word/ OpenOffice

Zum Publizieren bietet Ihnen EndNote mit der Cite-while-you-write-Funktion (CWYW) eine direkte
Moglichkeit von Microsoft Word aus auf die EndNote Datenbank zuzugreifen und Referenzen
einzufigen. EndNote erstellt dann nach Vorgabe einer Formatvorlage (Output Style) die
Referenzliste aller zitierten Referenzen. Die dazu notwendigen Befehle befinden sich bei Word
2003 unter ,, Ansicht—>Symbolleisten, bei 2007 und 2010 in einem Reiter der Multifunktionsleiste®
— Abbildung 27.

Start Einflgen Seitenlayout Verweise Sendungen Uberprifen Ansicht EndMote X5 Acrobat

EM Go to EndNote Style:  Annotated - Export to EndMote ~
. ___‘r Edit & Manage Citation(s) = Update Citations and Bibliography Gﬁl Preferances
Insert
Citation = ?:,gEdit Library Reference|s) Q)Comrert Citations and Bibliography ~ ? EndMote Help

Citations Eibliography ] Tools
Abbildung 27 | EndNote-Integration in Office 2010

Des Weiteren finden Sie unter den folgenden Links Video-Anleitungen zur CWYW-Funktion in
OpenOffice (Windows) und Apple Pages.

Auch fiir Nutzer von BibTex besteht die Moglichkeit des Exports in das korrekte Format. Unter
ftp://support.isiresearchsoft.com/pub/bibtex/ werden die hierflir nétigen Dateien fur EndNote
bereitgestellt. Lesen Sie sich im Vorfeld die Readme-Hinweis-Dateien (.txt-Files) durch.

Weitere Hilfe zur Installation von EndNote erhalten Sie unter den folgenden Links:

http://endnote.com/support/helpdocs/ENX5 GettingStartedGuide MacWin.pdf - EndNote
Handbuch

http://endnote.com/training/tutorials/EndNoteX5/Menu 970x562/EndNoteX5.html - Online
Tutorial

! Quelle: Adept Scientific GmbH, EndNote Manual, Version 4, 07/2011
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https://www.youtube.com/watch?v=ZQGMHZtNP5M
https://www.youtube.com/watch?v=pLHqVlD0l2o
ftp://support.isiresearchsoft.com/pub/bibtex/
http://endnote.com/support/helpdocs/ENX5_GettingStartedGuide_MacWin.pdf
http://endnote.com/training/tutorials/EndNoteX5/Menu_970x562/EndNoteX5.html
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